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This document, which supplements online help and other product information, contains 
important facts about hp OpenView internet services (OVIS).
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Announcements

HP OpenView Internet Services is copyrighted and licensed by Hewlett-Packard 
Company. Please refer to the licensing agreements on the installation media.

●     Probe Builder 1.1 is releasing in parallel with OVIS 5.20! This release is primarily a patch 
release, but contains greatly enhanced documentation to enhance your probe building 
activities. The software can be found at the URL contained in the OVIS 5.20 installation menu. 
A coming release of Probe Builder will add support for Java FAT Clients, Oracle Applications, 
and other cool new features! For more information regarding the OVIS Probe Builder, refer to 
the following URL: http://devresource.hp.com/drc/unifieddev/probe.jsp

Future Release:

●     The X-SLAM Cisco Integration probe will no longer be included in future releases of OVIS.

file:///C|/FrontPage%20Webs/Content/hpovreports/releasenotes/IOpsReleaseNotes.htm (1 of 32) [4/22/2004 10:21:48 AM]

http://devresource.hp.com/drc/unifieddev/probe.jsp


Internet Services 5.20 Release Notes

Back to Contents

What's New in OVIS 5.20

If you are upgrading directly from OVIS 4.5 to OVIS 5.2 you can select this link to see What's New in 
OVIS 5.0 and thus also available to you in OVIS 5.2.

The following are new features in OVIS 5.20:

SERVICE OBJECTIVE DEFINITION

●     SLO Expressions - You now have the ability to define a Service Level Objective based on 
multiple metric values within a single probe execution.

ALARMING

●     Alarm expressions - You can now define an alarm for a severity based on multiple metric 
values in the same probe execution.

●     New "sliding window" option allows you to define alarms based on a percentage of time a 
threshold is exceeded.

●     Alarming per step feature has been added for multi-step probes such as HTTP_TRANS, Script 
probe, and probe builder probes.

●     Added PSTIME and PSTS  (time when measurement was taken by the probe) as keywords in 
the alarm message.

DOCUMENTATION

●     New and improved Web Transaction Recorder manual.
●     Enhanced OVIS User's Reference Guide including a new Scalability section in chapter 7 and 

more Troubleshooting information in chapter 6.

CONFIGURATION MANAGER

●     New Locking capability for multiple users working in a single Configuration Manager.
●     Documentation has been added to explain non-admin user requirements for the Configuration 

Manager.
●     Turquoise "x" icon for disabled targets or service groups. 

PROBES

●     HTTP, HTTPS, HTTP_TRANS, and SOAP probes - Improved error messages have been 
added for better root cause analysis.

●     Script probe - better labeling of multi-step targets on script failure.
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●     Exchange, Mail Round Trip, and SMTP mail probes - custom header and footer is now allowed 
in message text.

INTEGRATION

●     OVO for Windows 7.21 - The OVIS integration has been enhanced from opcmsg integration to 
full Service tree and policy integration.

●     NNM 7.0 integration.
●     Ability to selectively import from OVTA, probe data, user data, or a combination of the two.

PLATFORM SUPPORT

●     Windows Server 2003 support for management server and probes.

DASHBOARD

●     Dashboard numeric values added into horizontal bar charts if there is room to do so
●     Dashboard Status now indicates when a target is disabled
●     Dashboard Status enhanced to sort by Status so Available, Unavailable, and Disabled targets 

are grouped.

PERFORMANCE AND SCALABILITY

●     Data base tables are indexed for quicker access. Please note that for Oracle and SQL data 
bases this requires that your DBA periodically maintain these indexes to insure the indexing is 
beneficial.

●     Trace file overhead lowered in IIS modules measevent2 (alarm mgr), distribmgr (distribution 
manager), and AlarmEvent (Event db alarm posting).

●     Datetime, customer and service group indexes added to all six data tables. Please note that for 
Oracle and SQL data bases this requires your DBA periodically maintain these indexes to 
insure the indexing is beneficial.

TROUBLESHOOTING

●     Enhanced LogStat.vbs utility to collect needed diagnostic information for use by hp support.

The following are important changes in OVIS 5.20: 

UPDATES TO SUPPORTED PLATFORMS: 

●     Management server and probe systems are now supported on Windows Server 2003. 
●     Windows NT 4.0 is not supported for the server or the probes. 

FILE LOCATIONS: 
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●     httptrans.dat - In OVIS 5.0 the web transactions definition file's save location  changed from 
the OVIS probes directory to the Data\Datafiles directory on the management server. It is still 
distributed to the probes directory on both the management server and remote probe systems 
whenever the configuration is saved. 

NEW DATABASE FIELDS: 

Data fields added- The CONSUMER (VARCHAR 128) field was added to the IOPS_DETAIL_DATA, 
IOPS_DETAIL_DATA_DAILY, and IOPS_DETAIL_DATA_HOURLY tables in the 5.0 release.

Back to Contents

 

Before You Install

There are different considerations for new OVIS installations and for updates to existing OVIS 
installations.  These are referred to as "NEW" or "UPDATE" (below). Also see the Security Alert 
section that follows.

NEW AND UPDATE: 

1.  Windows Server 2003 WARNING: By default Windows Server 2003 systems have Internet 
Explorer Enhanced Security enabled with very restrictive access.  You must change the 
configuration to prevent all basic OVIS communication functions from failing with various HTTP 
errors.  See problem R555028853 in the “Known Problems” section “Communications” 
subsection for Workaround information

2.  Check the Microsoft web site for the latest service pack and hot fixes to keep your systems up 
to date with known security fixes.

3.  Check the "Installation Prerequisites" section in Chapter 2 of the OVIS User's Reference Guide 
to make sure you have the required hardware and software for both the management server 
and probe systems.  UPDATE users need to check this since minimum requirements and 
supported platforms and operating system versions will change over time.

4.  Check the "Integration with other OpenView Products" section of these release notes to make 
sure you are integrating with the correct versions and patch levels for other OpenView 
products.  UPDATE users need to check this since these versions may change from one OVIS 
release to another.

5.  If you currently run, or plan to run, OVIS communications over the Internet Information Server's 
SSL Port rather than TCP Port (see Internet Information Services > Default Web Server > 
Properties > Web Site tab), you must apply the Workaround for problem number 8606343989 
described in the "Known Problems / Communications" section of this document AFTER 
installation of the OVIS 5.20 management server software.

6.  Installation is not supported over Terminal Services.  See "Resolving Install or Uninstall 
Problems" section of these Release Notes for more information.

7.  Existing SQL 2000 SP3 and MSDE SP3 Reporter data base instances running on the 
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management server will be converted to SP3A, and MSDE data bases created as part of a 
new installation will be SP3A versions.

UPDATE:

1.  When upgrading an existing OVIS Management Server and Windows or Unix remote probe 
systems from OVIS 4.5 or greater to OVIS 5.20, DO NOT uninstall the pre-existing version and 
then install the newer version as this can cause the loss of critical settings and data. You can 
install OVIS 5.20 over the previous version. 
See Step 10 Updating the NNM Integration Component and Step 11 Updating the OVO Unix 
Integration Component below for important information on removing previous packages prior to 
updating to the 5.20 versions on the integration components.

2.  A direct upgrade from either the 3.X or 4.0 release to OVIS 5.20 is not supported.
3.  Before installing, remove any OVIS patches listed in Add/Remove programs.  If this is not done 

before installing OVIS 5.20, patches may be removed later without impacting the current 
install.

4.  Update both the management server and the remote probe system software at the same time 
to keep data and configuration synchronized.

5.  Do not shut down or unlink the database during installation since table modifications and probe 
additions are done during this process.

6.  For Oracle database users, it is recommended that you consult with your DBA before 
installation on the following issues:

●     Make sure there is sufficient free space in the table spaces that hold rollback 
segments, the Reporter database, and indexes.  As mentioned in the “What’s 
New” sections, fields and indexes are being added to the detail data tables.  
This is done for the whole table at a time.  Depending on the amount of data in 
the tables, extra capacity may have to be added to the table space and the roll 
back segments. The installation will fail if the required database updates do not 
complete. 

●     Check the Data\status.reporter file for the following warning message to 
see if there has been a problem removing aged data records through nightly 
maintenance: 

WARNING: RepMaint IDLE TIME OUT after xx Minutes; 
‘Repmaint.exe’   

where xx is a number.  If you are seeing this message, create the 
HANG_TIMER DWORD registry key under 
HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\The 
Reporter\CurrentVersion. 

Set the HANG_TIMER value to at least 45 (decimal). Set the trace level to 9 in 
the OVIS Configuration Manager. Then run repmaint from a Command 
Prompt window to do the maintenance immediately assuming it is not a peak 
activity time. This may take a long time to run depending on the number of 
records that need to be truncated. Look at the end of the trace.repmaint 
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file to track progress and verify successful completion before doing the OVIS 
5.20 installation.

7.  For Oracle or SQL data base users, check with your DBA to make sure they enact 
maintenance procedures for the new indexes in the data tables. The installation added indexes 
for the fields DATETIME, CUSTOMER_NAME, SERVICE_NAME, and PROBENAME on the 
table IOPS_PROBE_DATA, IOPS_PROBE_DATA_CACHE, IOPS_PROBE_DATA_DAILY and 
indexes for the fields DATETIME, CUSTOMER, SERVICENAME, PROBENAME on the tables 
IOPS_DETAIL_DATA, IOPS_DETAIL_DATA_HOURLY, and IOPS_DETAIL_DATA_DAILY. 
Note also that for new data bases the SYSTEMNAME field is no longer indexed because OVIS 
no longer uses it. You may wish to have your data base administrator delete that index on any 
data of the data tables mentioned above in which it appears.

8.  If the logon account for the "HP Internet Services" service was changed from the Local System 
account to a user account, the logon account will be changed back to the "Local System" 
account during the software installation.  
After the upgrade is complete, you may reset the logon account to the previous setting via the 
Start > Settings > Control Panel > Administrative Tools > Services selection. Right-click 
"HP Internet Services" in the list of services and select Properties. Then select the Log On 
tab and check "This account" and browse to select the desired logon user account.

9.  For Remote Probes: After you have installed or updated the software on all remote probe 
systems, you must "Save Configuration" in the OVIS Configuration Manager in order to collect 
data on those remote probe systems.

10.  If you are using NNM Integration, you should first remove the existing integration components 
and then update to the new version of OVIS 5.20 integration software on the NNM Console.  
This will bring in support for new probes as well as update the integration in general.

11.  If you use OVO UNIX integration, Prior to updating to the OVIS 5.20 OVO UNIX integration 
component, be sure to remove all previous templates and associated template groups. See 
"Integration with OpenView Operations for Unix" section in the User's Reference Guide for 
more information.  

12.  Please refer to the Known Problems and Workarounds section of these Release Notes for 
information that may pertain to your installation. 
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Security Alert  
ORPHANED “OVOPS” INSTANCE: When you switch from the default "OVOPS" instance of the 
Reporter database to either Oracle or MS SQL Server 2000, the normal procedure leaves the default 
“OVOPS” instance in place.  This allows the flexibility of switching the database back to that instance 
via a simple ODBC configuration if needed.  This instance, though not in use by OVIS, may be 
vulnerable to the “Slammer” worm or other viruses. To eliminate this vulnerability, you may either:

●     Delete the instance.  This is the preferable option if you know the instance is not in use by 
OVIS or another product such as Reporter or Operations for Windows (OVO).  It also prevents 
future vulnerabilities this instance may have.  The procedure for this is to:
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1.  Copy the repair.vbs file from the OVIS media CD under \Support\Support 
Tools to a local empty folder on the system. \Support\Support Tools to 
a local empty folder on the system. 

2.  Open a command prompt to the location where the file was copied and enter 
the following command line:
cscript repair.vbs -remove //T:999 

3.  This starts up a menu where you can select/un-select components for removal. 

4.  Click the Un-select all button and then select only the "Microsoft SQL Server 
Desktop Engine" checkbox. 

5.  Click the Remove Components button and wait for the uninstall to complete. 

6.  Click the Exit button to terminate the script.

WARNING: If the Delete Instance procedure above does not 
successfully complete for any reason, there is an additional  procedure 
on the CD in the Support\Support Tools directory.  This procedure 
should only be used as a last resort.  It is recommended to contact a 
support representative before using it. 

●     Update the instance to MSDE Service Pack 3A.  Instructions are contained on the Microsoft 
web site.

If you have chosen to switch from the default MSDE 2000 database to SQL 2000, it is your 
responsibility to check that the Microsoft SQL Server 2000 Service Pack version is updated for the 
appropriate security level.  The OVIS 5.20 installation does not check for this.

NOTE:  The OpenView Reporter and Operations for Windows products share the same Reporter 
database with OVIS if the servers are installed on the same system.  Thus a new installation of OVIS 
installed on a system with a Reporter or Operations for Windows MSDE 2000 “OVOPS” instance will 
update the MSDE OVOPS instance to SP 3A to ensure security on that instance.

Back to Contents

 

OVIS Supported Platforms

OVIS Management Server is supported on the following platforms:
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●     Windows 2000 Professional/Server/Advanced with Service Pack 4
●     Windows 2000 Datacenter Server is supported, however advanced features of Datacenter 

Server
such as cluster/failover are not supported

●     Windows XP Professional with at least Service Pack 1
●     Windows Server 2003 Standard and Enterprise editions

OVIS Windows probes are supported on the following platforms:

●     Windows 2000 Professional/Server/Advanced with Service Pack 4
●     Windows XP Professional with Service Pack 1
●     Windows Server 2003 Standard and Enterprise editions

OVIS UNIX probes are supported on the following platforms:

●     HP-UX 11.0, 11.11, 11.22 (Itanium), 11.23
●     Solaris 2.7, 2.8, 9
●     Linux Red Hat 7.1, 7.2, 8.0, ES 2.1, ES 3.0
●     SuSE Linux Enterprise Server 8.1 and SuSE Linux Professional 8.1

Note that the following probes are not available on UNIX: Streaming Media, XSLAM CiscoWorks, 
SMS, ODBC, Exchange, and OVTA integration service types - WEBAPP, SOAPAPP, JMSAPP, 
RMIAPP, COMAPP.  HTTP_TRANS probe in Internet Explorer heavyweight mode is not available on 
UNIX but is available in URL mode on UNIX systems. NTLM authentication is not available on UNIX in 
the HTTP, HTTPS, SOAP and HTTP_TRANS URL mode probes but the other authentication modes 
are supported. The Dial probe is available on windows and all UNIX platforms except SuSE Linux. 

Databases - The following databases are supported:

●     Microsoft SQL Server 2000 Desktop Engine Service Pack 3A running on Windows 2000 
Service Pack 4, Windows XP Professional Service Pack 1, or Windows Server 2003

●     Microsoft SQL Server 2000 Service Pack 3A running on Windows 2000 Service Pack  4 or 
Windows XP Professional Service Pack 1

●     Oracle 8.1.7 running on HP-UX 11.0 (32-bit) or Solaris 2.7, 2.8
●     Oracle 9.2.0 running on HP-UX 11.0 (64-bit), 11.11 or Solaris 2.7, 8, 9 (32-bit and 64-bit)

The following databases were supported in previous versions of OVIS and are now supported only on 
upgrade:

●     Microsoft Access 2000

The following browsers are supported for the OVIS Dashboard:

●     Microsoft Internet Explorer 5.5 with Security Update and with Service Pack 2 or above
●     Microsoft Internet Explorer 6.0 with Security Update
●     Netscape 4.7,6.2, 7, 7.1
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OVIS reporting component uses Crystal Reports 8.5

See the section below and check the OpenView web site for current information 
on compatibility of OVIS with new releases of OVO, NNM and other OpenView products.

Back to Contents 

  

  

Integrating with Other OpenView Products

OVIS integrates with the following OpenView products and versions:

●     hp OpenView Reporter A.03.50 
●     hp OpenView Service Information Portal 3.1
●     hp OpenView Performance Manager OVPM A.04.04 and C.05.05
●     hp OpenView Performance Agent 3.x/ARM and 4.0/ARM
●     hp OpenView Operations for Unix version 7.1 (HP-UX and Solaris)
●     hp OpenView Operations for Windows version  7.20 (opcmsg integration only), 7.21 (full 

service tree integration)
●     hp OpenView Network Node Manager 6.2, 6.41 Windows 2000, HP-UX (not supported on HP-

UX 10.20), and Solaris; NNM 7.0 Windows 2000, HP-UX (not supported on HP-UX 10.20), and 
Solaris; NNM 7.01 Windows 2000, HP-UX (not supported on HP-UX 10.20), and Solaris

●     hp OpenView Transaction Analyzer 2.0 and 2.1

OVIS includes the following embedded components:

●     Reporting component version A.03.50
●     Graphing component version A.04.04

Check the OpenView web site (www.openview.hp.com) for current information on compatibility of 
OVIS with new releases of other OpenView products.

Back to Contents 
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OVIS Languages, Product Names, Product Numbers

OVIS is available in English and Japanese languages. 

Product Number - English  Product Name
J4510CA OVIS 5.2 Media - English 

J4511CA OVIS 5.2 Manuals - English

  
J4512AA LTU - Base license, including 5 pack - English

J4513AA LTU - Additional 5 pack - English

J4530AA LTU - Additional 5 Custom Probe pack - English*

J4515AA LTU - Additional 25 pack - English

J4531AA LTU - Additional 25 Custom Probe pack - English*

J4516AA LTU - Additional 250 pack - English

* Note that Custom targets and probes are only available with the English version. 

Product Number - Japanese  Product Name
J4510BJ OVIS 5.0 media - Japanese

J4511BJ OVIS 5.0 Manual - Japanese

  
J4512AJ LTU - Base License, Including 5 pack - Japanese

J4513AJ LTU - Additional 5 pack - Japanese

J4515AJ LTU - Additional 25 pack - Japanese

J4516AJ LTU - Additional 250 pack - Japanese

To activate the measurement server and manage Internet Services, you need to purchase
a Base license (LTU), product number J4512AA (English) or J4512AJ (Japanese), which
includes your first five (5) configured targets.  If you require more than five targets, you
can purchase one or more add-on packs.  Licensing is based on the total licensed capacity which is 
calculated by adding up the total number of configured targets (OVIS probe and Custom probe based). 

Back to Contents 

 

Known Problems / Limitations and Workarounds 

file:///C|/FrontPage%20Webs/Content/hpovreports/releasenotes/IOpsReleaseNotes.htm (10 of 32) [4/22/2004 10:21:48 AM]



Internet Services 5.20 Release Notes

The following areas of Internet Services are either incomplete or known to not function as 
expected in the A.05.20 release.  Note that the first number listed (e.g., R555025033) is the number 
used in OpenView's eCare web site http://support.openview.hp.com, and the second number (e.g., 
(ROSmm31614)) is an hp internal-only CR number that may be useful in talking with your hp support 
representative. 

For ease of reference the known problems listed below have been subdivided into the following 
sections:  

●     Communications 
●     Install/Uninstall  
●     Database  
●     OVTA Integration  
●     OVO Integration  
●     Dashboard  
●     Web Transaction Recorder  
●     Probes 
●     Japanese Characters  
●     Custom Probes SDK  
●     NNM Integration

Communications:

R555028853 (ROSmm35745): Alarm engine fails to start on Windows Server 2003 running terminal 
services 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028853
Workaround: Internet Explorer Enhanced Security is a new feature from Microsoft to control the web 
sites your users can browse on your system. When enabled (which is the default for Windows Server 
2003 installations) this prevents users from browsing untrusted websites. This will also cause warnings 
of potentially malicious software if you try to install OVIS software from a share. You also see this 
when browsing on the local system with Internet Explorer. You can work around this problem in either 
of the following two ways:

1.  Disabling "Internet Explorer Enhanced Security Configuration". This will work for local logins, 
but will not work for users running the OVIS configuration manager over a Terminal Server 
session. 

From the Control Panel, select Add/Remove Programs and then select Add/Remove 
Windows Component from the left-hand pane. From the Windows Components Wizard 
dialog, deselect Internet Explorer Enhanced Security Configuration, select the Next 
button, and then select the Finish button to Complete the Windows Component 
Wizard. Then restart IIS Admin Service. 

2.  Adding the sites required by OVIS to your Internet Properties Local intranet or Trusted Sites 
configuration. This will work for both local and Terminal Server logins.
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From the Control Panel, select Internet Options and then select the Security tab. You 
are going to add sites to either your Local intranet or Trusted sites zone, depending 
on which is appropriate for your desired level of security. Select the appropriate zone 
and then select the Sites button. Use the resulting dialog to add both 
http://<hostname> and http://<hostname>.<domainname> where hostname is the name 
of the OVIS management server. You may also add file://<hostname> if you wish to 
eliminate file browser warnings and warnings when trying to install OVIS software from 
a share. Then select the OK button, and restart IIS Admin Service. 

More information on Internet Explorer Enhanced Security model on Windows Server 2003 can be 
found at URL 
http://msdn.microsoft.com/library/default.asp?url=/workshop/security/szone/overview/esc_changes.asp

8606330897 (JAGae92018): Repmaint times out and so HDD gets filled out fast. (Large Databases 
May See Repmaint.exe Hang).
There is a potential problem with large databases and repmaint. This can occur in all reporter versions 
that ship with OVIS A.04.50, A.05.00, and A.05.20. If the database is very large (millions of records, 
more than 2GB in size), it is possible that repmaint stops truncating the OVIS data tables. The 
trace.repmaint and status.reporter show an entry similar to:
IDLE TIME OUT after x Minutes; 'RepMaint.exe'
After that, repmaint may hang.
This seems to be a "known" reporter problem and documented in the reporter troubleshooting 
information. However, if the data isn't truncated anymore, the database will grow and performance for 
all programs accessing the database will degrade. In addition, it is not obvious that this is in fact a 
critical problem since the status only says "Warning" instead of "Error".
eCare Link:  http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=8606330897 
Workaround 1 - Create Hang_Timer Registry Key. To workaround this issue, create the registry key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\The Reporter\CurrentVersion\Hang_Timer
The default is 3 (in minutes), try something like 30 or larger.  However at one site it had to be set to 45 
for the problem to go away.  It is in the release notes to set this at 45.
Workaround 2 - Lower the Runtime Value for repmaint.exe in the Database.
One other possible solution is to lower the runtime value for repmaint (default is 800) in the database.  
This will hopefully avoid the problem of repmaint hanging the system, since the scheduler will kill it 
much sooner then the default and the theory is that it will kill it before it hangs, however in practice this 
is not always true.  Also if the scheduler kills it before it finishes then you will have more data (then as 
set in retain days) in the dashboard and in the reports, since repmaint did not remove the data before 
it was killed. 

Microsoft SQL Server 2000:
Method 1: Use the Enterprise Manger GUI for SQL and  
1. open the reporter database
2. edit the scheduler table
3. find the row for repmaint.exe
4. change the runtime value to 60.
Method 2: You can use osql:
1. start a command prompt window
2. osql -S.\OVOPS -Uopenview -Popenview
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3. use reporter
4. go
5. update schedule set runtime=60 where program='Repmaint.exe'
6. go

Oracle:
Method 1: Use the Oracle DBA Studio and  
1. open the reporter database
2. edit the scheduler table
3. find the row for repmaint.exe
4. change the runtime value to 60.
Method 2: You can use SQL Plus Worksheet:
1. connect to the reporter DB with the correct user/password
2. update schedule set runtime=60 where program='Repmaint.exe'

Note 1: that if you are not using the user openview with password openview you will need to change 
these to what ever user/password you are using.  
Note 2: If you upgrade OVIS or install full reporter then this value will revert back to the default of 800 
and you will have to change it again.
Note 3: This is not a supported thing to do, so be very careful

Workaround 3 - Get Reporter Hot Fix for Repmaint.exe - JAGae92018.
One more possible solution is the CR: JAGae92018 against Reporter will be released in the next 
release.  Note this CR was moved to resolved state and a patch was released, however it did not fix 
the problem.  They should have moved it back to Open and then put in a fix that will let you set the 
block size of the deletes in the registry (default is 12 hours).  There is a hard coded hot fix set at 4 
hour blocks but only one customer so far has tried it and the results are inconclusive that this worked.  
Also note that the hot fix and patch also contain an introduced defect to the uptime reports (they will be 
one hour off).

Some Other Things to Consider
1. If this is a very large Database (500,000 or more rows in the iops_detail_data table) you might want 
to stop the OVIS and Reporter service and run repmaint by hand to let it catch up.  This could run for 
several days depending on how far behind it is.
2. You can find out how out many days repmaint it behind by running a sql query to find out the max 
and min of the column datetime.  
Select min(datetime), max(datetime) from iops_detail_data;
Then looking at the value you have in retain days for the detail data (5 minute data). 

8606343989 (JAGaf04841): No Probe Info condition because repcrys changes web server port value.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=8606343989
Workaround: Rename the SetWebServerPort.vbe program in the OVIS bin directory to 
SetWebServerPort.a0520.vbe and replace it with the one from the CD (or CD image) Support\Support 
Tools directory. 

Install/Uninstall:

R555025033 (ROSmm31614): In OVIS releases 4.5 and earlier, an uninstall of OVIS removes 
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customized data table retention days settings. This is fixed in OVIS 5.0 but is provided in the 5.20 
release notes to make you aware that if you uninstall 4.5 before installing 5.20 you will encounter this 
problem.  There is no need to uninstall 4.5 prior to installing 5.20, just overinstall.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025033
Workaround: Reset the retain days setting in the OVIS Configuration Manager via File > Configure > 
Database > Options BEFORE scheduled maintenance runs and deletes data (typically after 
midnight).  If you wish to update from OVIS 4.5 to 5.20, simply do an install of OVIS 5.20 without 
uninstalling the previous version and this problem will not occur.    

R555025578 (ROSmm32199): Windows Remote Probes Upgrade from 4.5, or 5.0 to 5.20 does not 
always update Scheduler.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025578
Workaround: From the <install path>\bin directory, run perfstat -v and confirm all the 
executables are the correct version.  If a version is not correct, reboot the system and run perfstat -
v again to confirm the versions are correct. 

R555025248 (ROSmm31844): Uninstallation of OVOW 7.2 causes OVIS data to disappear.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025248
Workaround: The uninstallation deletes the DSN entry to the previous database and adds a new one 
with a MicroSoft Access driver specified. Use the procedure below to remove that DSN and add the 
proper one back. Note that you should see your existing data and configuration after successfully 
completing this procedure. If the OVIS database was the default Microsoft SQL Server Desktop 
Engine (MSDE) database then perform the following steps.  (For Oracle and SQL server, please follow 
the database specific steps as described in the OVIS Database Configuration guide.)  

1.  Stop IIS and Reporter

net stop iisadmin /y 
net stop reporter 

2.  Launch Control Panel select Administrative Tools > Data Sources (ODBC).

a.  In the ODBC Data Source Administrator, click System DSN tab. 

b.  Remove the Reporter DSN. 

c.  In the System DSN tab, create a new data source by clicking on Add. 

d.  In the Create New Data Source dialog select SQL Server, press Finish. 

e.  In the Create a New Data Source to SQL Server dialog, fill out the following fields 
and then click Next: Name: Reporter, Description: Reporter, Server: <local 
hostname>\OVOPS

f.  Select "With SQL Server authentication using a login ID and password entered by 
the user", enter the following login and password and click Next: Login ID: openview, 
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Password: openview 

g.  Change the default database to: Reporter 

h.  Click Next. 

i.  Click Finish. 

j.  Click Test Data Source and verify that connection was successful. 

k.  Press Okay.

3.  Run Repair.vbs (from the Support directory on the OVIS CD) 

4.  If above step doesn't force a reboot, Re-start reporter/iisadmin: 

net start w3svc 
net start reporter 

Note: It may take up to 1/2 hour before new data will show up in the GUI. This is due to the fact that 
iopscollector.exe and iopsmaint.exe are scheduled to run 1/2 hour from the time 
repair.vbs was executed. 

Optional: The OpenView Trace Server is no longer installed under the service menu. To install the 
service, simply run <install_dir>\bin\trcinst.exe. 

R555020624 (ROSmm26945): Removal of full Reporter removes registry keys. Symptoms include 
OVIS Configuration Manager unable to start with prompting for database password, and the OVIS 
dashboard is unavailable.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555020624
Workaround: Start the  Configuration Manager and it will prompt for a DB user and password. Enter 
the user and password for the database connection and most items will start working. (Typical - user: 
openview, password: openview.) To correct the missing virtual directory go into  IIS. Right-click on the 
Default Website and add a new virtual directory HPOV_REPORTS. Set the path to 
<install_dir>\data\webpages. Finally allow read, script, and execute permissions on the 
directory.
Alternative Method: On the original OVIS CD go into \Support\Support Tools and run 
repair.vbs. Inside of repair.vbs select only hp OpenView reporter, unselect all other installed 
items. Then click Repair Components. When the repair tool completes OVIS should be back to full 
functionality.   

R555025939: Uninstalling NNM 7 when installed with OVIS, breaks OVIS Config Mgr 
Workaround: On the original OVIS CD go into \Support\Support Tools and run repair.vbs. 
Inside of repair.vbs select only hp OpenView internet services, unselect all other 
installed items. Then click Repair Components. When the repair tool completes, OVIS should be 
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back to full functionality.

R555025012 (ROSmm31593): After upgrading from 4.X (with or without patch) or 5.0 to 5.20, 
choosing Shutdown from the Start menu does nothing.  The menu to select Shutdown, Restart, Log 
off, ... does not appear.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025012
Workaround: Pressing Ctrl-Alt-Delete brings up the Windows Security menu and the system can be 
restarted and shut down from there.   

R555022532 (ROSmm28914): You cannot uninstall OVIS after NNM integration uninstallation on an 
NNM 6.4 or 6.41 system.
eCare Link:http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555022532
Workaround: Registry entry HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\HpOvLic- 
DependentProductList has an invalid value such as {E45D72D7-65EA-45F6-AA94-
3C304EA91AA2}. This GUID should be for an upgrade code of the msi package that is holding the 
dependency on the autopass package. Since the GUID that is inserted is invalid, the OVIS common 
installer fails to uninstall. As a workaround the value can be replaced with a valid value from another 
msi NNM component such as HPOvNmDep package: {76D04B27-5036- 49DB-B383-
1165C8B2B4AF}. This should allow the OVIS installer to continue to perform the uninstall.

Problem: Reporter 3.01 or OVOW 7.10 console installed after OVIS 5.20 on the same system gives a 
misleading error message saying it finds a non-MSDE database instance even when the instance is 
MSDE.
Workaround: Ignore the message.  These installations are looking for an MSDE instance of .\OVOPS 
which has been changed to <hostname>\OVOPS.  This should not cause any problems since the 
application software itself looks for the Reporter DSN rather than the instance name.   

Problem: If OVIS 5.20 and either Reporter 3.01 or OVOW 7.10  console are installed on the same 
system, and then all are uninstalled, and then Reporter 3.01 or OVOW 7.10  console are reinstalled, 
they will not function until OVIS 5.20 is reinstalled.
Workaround: Reinstall OVIS 5.20.   

Problem: During reporter installation, the following error dialog might be shown by the installer:
"Error 1920. Service Reporter (Reporter) failed to start. Verify that you have sufficient privileges to 
start system services."
Workaround: This may be due to a failed deinstallation of a previous OpenView product.   Please 
verify the following:

1.  In the Services control panel applet, locate HP OpenView Trace Service. 
2.  If found, determine whether the OVTrace.exe executable shown in "Path to Executable" 

really exists. If it doesn't, run regedit and delete the registry entries for this service: 
a.  In regedit, go to  
b.  HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services  
c.  Highlight entry HPOVTrace and press Delete. 
d.  Reboot the system and start the installation again.   
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Problem: When OVIS is installed first and Web Transaction Observer (WTO) second, the uninstall of 
OVIS will break WTO, if OVIS is removed before WTO.
Workaround: Uninstall WTO before OVIS.   

R555013289 (ROSmm19194): At installation, IIS sub services such as FTP and SMTP are stopped 
and not restarted automatically.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555013289
Workaround: Start the services manually.   

Database:

8606330897 (JAGae92018): Removal of old data in database fails with a timeout.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=8606330897
Workaround: Contact support since there are multiple possible causes and potential solutions to this 
problem. 

R555025087 (ROSmm31674): Oracle 9.2.0.1 Client breaks OVIS Dashboard & MeasEvent.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025087
Workaround: On the Oracle 9.2 Client software you need to give the Authenticated User privilege to 
the Oracle Home by following these steps:     

1.  Log on to Windows as a user with Administrator privileges. 

2.  Launch Windows Explorer from the Start Menu and navigate to the ORACLE_HOME 
directory. 

3.  Right-click on the ORACLE_HOME folder and choose the Properties option from the drop 
down list.  A Properties window should appear.    

4.  Click on the Security tab on the Properties window.    

5.  Click on Authenticated Users item in the Name list (on Windows XP the Name list is 
called Group or user names).    

6.  Uncheck the Read and Execute box in the Permissions list (on Windows XP the 
Permissions list is called Permissions for Authenticated Users).   This box will be under the 
Allow column.    

7.  Check the Read and Execute box.  This is the box you just unchecked.    

8.  Click the Apply button.    

9.  Click the OK button.   

10.  Reboot your computer after these changes have been made.  Re-execute the application 
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and it should now work.       

R555028655 (ROSmm35531): measevent fails to continue running after database connection 
restored.  This will cause "no probe info" conditions and alarms indicating that no data is being 
received from probe locations.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028655
Workaround: Restart IIS. 

R555020567 (ROSmm26888): Error messages in newdb when Oracle is DSN. 
For example:
2003/01/13 10:19:41 (4):(1740) SQL Execute error; ORA-04080:
trigger 'CUSTOMER_MASTER_TRG' does not exist
2003/01/13 10:19:41 (4):(1740) Error -1; State:S1000,Native:4080,Origin:
[Oracle][ODBC][Ora]
...
2003/01/13 10:19:45 (5):(1740) Error opening [DISCOVERDOMAINS]; ORA-
00904: invalid column name
2003/01/13 10:19:45 (5):(1740) Error -1; State:S0022,Native:904,Origin:
[Oracle][ODBC][Ora]
2003/01/13 10:19:45 (5):(1740) Error opening [DISCOVERSYSTEMS]; ORA-
00904: invalid column name
2003/01/13 10:19:45 (5):(1740) Error -1; State:S0022,Native:904,Origin:
[Oracle][ODBC][Ora]
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555020567
Resolution: If you are installing OVIS with an Oracle database, you may see
a number of error messages in the trace files. You may ignore these messages.   

 

OVTA Integration:

R555023443 (ROSmm29875): You must restart IIS to enact any OVTA integration configuration 
change. This includes disabling, enabling, or changing configuration parameters in the integration. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555023443
Workaround: Restart IIS to enact any OVTA integration configuration change.

 

OVO Integration:

Problem: Whenever an OVO for Windows or UNIX agent is installed after OVIS, you must reboot in 
order to ensure that alarm forwarding works correctly.  

R555015851 (ROSmm21882): Cannot get OVIS alarms to appear in the OVO message browser.  
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555015851 
Workaround: Upgrade OVO agent to latest 7.x version plus any applicable patches. If this is not 
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possible because the OVO Unix or OVO Windows console does not support that agent version, then 
you must install both OVIS and the OVO agent on the C: drive due to an agent defect in the 7.0 
version. This may involve uninstallating all OpenView tools on this system and reinstalling them on the 
C: drive.

 

Dashboard:

R555025479 (ROSmm32096): Occasional missing graphics in Dashboard on non-Server Windows 
versions due to Microsoft’s limitation of 10 connections on Professional (non-Server versions).  
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025479
Workaround: Press the Refresh button on the browser.   

R555025064 (ROSmm31648): Using an http probe with a long url and a long Service Group
Name causes the Target Info link on Status web page to display no data
on Drill Down page. Also on Service Target Availability status tab, if
you right click and select Graph with OVIS Dashboard, the same thing
happens. Other http service targets work fine.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555025064
Workaround: Access Drill Down page from Availability or Response tabs.

R555028764 (ROSmm35646): No Data triangle appear in Time Series and Drilldown graphs for all the 
five minute data points between the hourly data point bars when graphing time periods for which there 
is hourly data but no five-minute data available. A more accurate graphic representation would be to 
show only the hourly data points since they do represent the whole hour. The implication of "no data" 
triangles at the five minute points is that there is missing data. That is not the case.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028764
Workaround: Ignore the "no data" black triangles at the five minute data points and interpret the 
hourly data point as representing the whole hour beginning at that time. For instance, availability of 
100% for the 3:00 pm data point represents the time interval 3:00 pm to 3:59 pm even though there 
are black "no data" triangles at 3:05 pm, 3:10 pm, etc through 3:55 pm before there is another data 
point at 4:00 pm.

R555018816 (ROSmm25018): From the Graphs web forms interface using a Java Graph, the Drill 
Down function does not work when Restricted Views is set in OVIS.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555018816
Workaround: None at this time.   

R555020960 (ROSmm27293):Service Group graph in the Dashboard shows Customer data. If a 
Service Group name is identical to the Customer name then in the Dashboard, the graphs for the 
service group will be that of the customer.  This only affects the Time Series graphs and the Drill Down 
graphs for the identically named service group.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555020960
Resolution: To prevent this problem do not name Service Groups and Customers the same.
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Web Transaction Recorder:

R555028547 (ROSmm35417): Webrecorder loses the ability to record raw clicks and keys.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028547
Workaround: Exit and reenter the web recorder.   

R555019258 (ROSmm25508): In the OVIS Web Transaction Recorder (HTTP_TRANS probe) IE 
Heavyweight mode, the transaction may fail if the first step is an https target and if a proxy 
is configured which requires authentication.  
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555019258
Resolution: If the transaction fails, install hot fix Q329802 from the Microsoft web page. 

Problem: If you encounter either of the following problems:
Popup boxes indicating that processes (particularly the probe processes or scheduler) are terminating 
abnormally due to initialization errors, or Problems with Web Transaction Recorder transactions 
recorded in Internet Explorer mode.
Workaround: All probes run under the "HP Internet Services" service, which by default is
configured to run as the System account.  If you encounter these problems, reconfigure the HP 
Internet Services "System Account" setting by selecting "This account:" and entering the account (user 
name) and password that recorded the transaction.  This applies to both the Management Server and 
remote probe systems.  This configuration information is accessed via the Computer Management > 
Services and Applications > Services > Properties > Log On selection.   

Probes:

R555028123 (ROSmm34950): httptrans probe IE mode may generate Temporary Internet Files that 
can fill up a disk drive.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028123 
Workaround: See Microsoft URL http://support.microsoft.com/?kbid=301057 for a discussion of 
problem, cause, and workaround.

Another option is to create a script probe to delete these files: Create a script that will delete the files 
out of the Temporary Internet Files folder. Then use the script probe in OVIS to run this script once a 
day. Give this probe a priority of 1 and all the other probes a priority of 2 so that when they do fire 
together once a day this script probe will run first before any of the other probes, to avoid any 
collisions. This script should be placed in the \newconfig\distrib\platform\windows directory so that it 
will only be distributed to windows boxes. Then under the probe location for that probe add all the 
systems where you are experiencing this problem. Here is an example of one script: 
attrib -s "C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files" 
del /Q "C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files\*.*" 
The first line in this script was required to remove the system attribute from this folder so the delete 
could take place, this could be different on your system. The /Q option for delete is so that it will not 
prompt before deleting the files. Also note this is the path to my Temporary Internet Files it could be 
different on your system. You might also have folders under this directory that you want delete so you 
would need to change this script for that as well. Also you could have file and/or folders under a 
different user that you want deleted, so again you would have to modify this script for that. 
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Here is a second example of how one of our customers modified the above script to suit their 
environment: 
rmdir /Q /S "C:\Documents and Settings\Default User\Local Settings\Temporary Internet 
Files\Content.IE5\"

R555028739 (ROSmm35621): OVIS's IMAP probe is unable to delete messages when the message 
pile up is over approx. 600 messages. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028739
Workaround: Delete the mail pile up by either configuring a POP3 probe to the same mailbox or by 
logging in with a mail interface and deleting them in that interface. Ensure that the IMAP probe is run 
frequently enough along with the SMTP probe, to avoid such a pile up.

8606344770 (JAGaf05620): OVIS drill down query for SMS probe queries for SMS not SMS_PROBE 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=8606344770
Workaround: While the problem itself is resolved in OVIS 5.20, there are two residual issues from the 
problem that may need to be worked around:

1. If you were running the SMS probe before the upgrade to OVIS 5.20, and they want to see their 
data in the dashboard from the previous OVIS 5.20 install, they need to run the following database 
query to fix the new SMS probe name on the Reporter database:

update IOPS_SERVICES set PROBENAME = 'SMS_PROBE' where PROBENAME = 'SMS';

2. If you have a config.xml file that was saved prior to OVIS 5.20, you need to change the probe name 
in the XML file from "SMS" to "SMS_PROBE", in order for the xml file to load correctly in OVIS 5.2 and 
beyond. For example, change from: 
<SERVICE id="Test" probe="SMS"> 
to: 
<SERVICE id="Test" probe="SMS_PROBE">

After changing the probe name, the old XML file should load without any problems.

8606307469 (JAGae70502): SAP probe shows no data instead of unavailability when it times out. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=8606307469
Workaround: None.

R555028831 (ROSmm35721): SAP probe trace has password in clear text. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555028831
Workaround: None.

R555020596 (ROSmm26917): SAP probe produces *.trc files in probes directory. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555020596
Workaround: Delete the trace files.
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Japanese Characters in the Dashboard:

R555014853 (ROSmm20840): Japanese Characters in the Dashboard are incorrect with Netscape 
4.7.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555014853
Workaround: The workaround can also be applied to other language sets. In versions of Netscape 
earlier than 6, Japanese characters can be incorrect or appear as blocks. To fix this, inside of 
Netscape go to Edit->Preferences. Then in the Preferences window select the tree item Fonts under 
Appearance. 

In the Fonts window select the language that you are having problems with, in this case Japanese. 
Make sure that the fonts selected are appropriate for the encoding. Then change the setting for 
document fonts from "Use document-specified fonts, including Dynamic Fonts" to "Use my default 
fonts, overriding document-specified fonts". Click OK and refresh the screen. Repeat as necessary for 
additional encodings. After this change the Japanese characters will appear correctly in Dashboard 
reports.   

Custom Probes SDK:

R555024864 (ROSmm31415): In the Custom Probes SDK the command line switch must be prefixed 
by a "-". You can not use a "/". This was implemented as an enhancement to allow a file name which 
might include a leading "/" to be used as a parameter in the script probe and others. This is a common 
requirement for scripts run on Unix systems. 
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555024864
Workaround: Use "-" instead of "/" for a command line switch. 

NNM Integration:

There are several known minor issues with the OVIS/NNM integration package, most with simple 
workarounds. 

Problem: ODBC Roll Forward/Backward Errors 
Cause: Occasionally, stopping the NNM services (ovstop) while ovw is running can later cause the 
database to fail to start with error messages stating that "Roll Forward" or "Roll Backward" operations 
failed. This problem has only been seen so far on Windows NT. The problem is a corrupt database log 
file. This problem has been improved with the new Solid Server (3.51) shipped with NNM 6.2, however 
the problem has still been observed only at lesser frequency.
Workaround: Run the command: $OV_BIN/ovisdb.ovpl -cl -restart 
The database should then be running normally, without loss of data.

Problem: ODBC Cannot Find Source "tcpip 2691" 
Cause: Occasionally, the database does not shutdown properly. This is also believed to be related to 
running ovw sessions when ovstop is issued. 
Workaround: Run the command: $OV_BIN/ovisdb.ovpl -restart to properly shutdown and restart the 
database, without loss of data.

Problem: Symbol Display 
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Cause: There are a few scenarios where commands are stored to the command database, but are not 
performed on an open map. This happens, for example, if the persistence level is not set to "All 
Levels" (see the Internet Services User's Reference Guide), or if the node is not managed by NNM. 
The NNM menu choice >Internet Services—> Rebuild Internet Services Symbols causes NNM to 
delete all symbols that have the "ovisIsOVIS" field set TRUE, and then reperforms all commands in 
the command database. This ensures that the map reflects what is currently in the database. 
Workaround: There are mechanisms built into the integration package to recover missed 
configuration changes and alarms. However, if you suspect that NNM is not synchronized with OVIS, 
the script $OV_BIN/ovisclean.ovpl completely clears the command database and causes NNM to pull 
all of the latest configuration and alarm data. The script also rebuilds all symbols. Before running 
ovisclean.ovpl, make sure to shut down any running OVW sessions. 

Problem: Multiple Service Groups of the Same Type do not display correctly.
Cause: Because service symbols are created by type (HTTP, DNS, FTP, etc.) no distinction is made 
between service groups of the same type for a given target node. In other words, if you configure two 
service groups, such as SG1 and SG2, that are both HTTP service groups, and both service groups 
contain the target node foo.com, you can see that on the NNM map the node symbol for foo.com 
contains only one HTTP service symbol. All alarm symbols for both SG1 and SG2 are created under 
this one HTTP service symbol. More importantly, if you later delete one of these service groups, the 
NNM integration package responds as though the entire HTTP service is being deleted, and removes 
the HTTP symbol under foo.com. 
Workaround: Run the ovisclean.ovpl script to restore the remaining service group.

Problem: Changing Customer Name in OVIS is not automatically updated by NNM. As a result, 
events targeted to that customer are logged as errors, and the symbol reflecting the customer's old 
name is not updated.
Workaround: Run the ovisclean.ovpl script to force the NNM integration to re-establish the customer 
under the new name.

Problem: Inconsistent Customer Views Status Propagation between NNM and OVIS.
Cause: In cases where Customer Views is installed on the NNM node that is integrated with OVIS, 
there is inaccurate status propagation to customer symbols displayed in Customer Views symbols. For 
any OVIS target node that serves more than one customer, the status propagation to the node reflects 
the status of all the customers served by the node. However, if a customer symbol in Customer Views 
has that node beneath it on the hierarchy (for example, in the "Servers" container), the status of the 
customer symbol reflects the status of all customers served by that node. This is due to the fact that 
OVIS integration creates a child symbol for each customer served by a given node, and thus the 
node's status is determined by the status of all its customers. Because the customer symbol in 
Customer Views obtains its status from the node, the status for a given Customer Views customer 
symbol becomes a function of all customers served by the node. The problem arises from inconsistent 
modeling of customer, service, and targets between NNM and OVIS.
Workaround: At this time there is no fix or workaround for this problem.
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Resolving Install or Uninstall Problems
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Installing OVIS via Terminal Server

R555020757 (ROSmm27083):  Using Terminal Server to install OVIS is not supported due to a high 
likelihood of failure. Our testing failed much of the time when using Terminal Server in Remote 
Administration mode and installing from a Network disk. Although still not supported, better results 
were obtained when using Terminal Server in Remote Administration mode and installing from a CD or 
a local disk. Using Terminal Server in Application Mode is prohibited by the installation software unless 
you are on the console.
eCare Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?docid=R555020757

Using LogStat.vbs.

Synopsis:

The LogStat.vbs script, which is located on the OVIS Installation CD in the Support\Support 
Tools directory or disk area (and is also installed into the <install dir>\bin directory), can be 
used in situations where the installation has failed and you need to bundle up the installation status 
files and other system information for support personnel. This script creates a file called 
installatonlogs.htm in the [DATADIR]\HPOVInstall folder whose size will be on the order 
of ten megabytes. Since it is character data, it will compress very well by using a "zip" utility.

Required software:

This script is written in vbscript and requires Windows Scripting Components, Internet Explorer 5.0 or 
better, and Windows Installer Service to execute correctly.

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run it as well. It has no 
options. From a command line prompt window you can execute LogStat.vbs as follows:   
c:>cscript LogStat.vbs <options> 

Using repair.vbs.

Synopsis:

The repair.vbs script, which is located on the OVIS Installation CD in the Support\Support 
Tools directory or disk area, can be used in situations where the installation has failed to uninstall or 
special cases where you would like to uninstall specific components. This script can also be used to 
restore files that may have been deleted through system or user intervention on the server. The script 
only operates after a properly installed product is present on the system so the script cannot be used 
as a primary means of installation. The script will use the existing windows installer components to 
determine which components can be repaired or removed via the script. The script will also create a 
log in the [DATADIR]\HPOVInstall folder that can also be collected by logstat.vbs. 
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The repair.vbs script will require the original OVIS CD when attempting to run a repair. This is mainly 
because un-versioned files must always be re-installed from the source media during a repair action. If 
the source media or original install software is not available the installer will prompt you for the location 
of the msi file that is currently being installed. You can then use the browse button to locate the folder 
SETUP on the install source media, then further locate the folder containing the requested msi file. 

The repair.vbs script needs to be copied from the OVIS Installation CD Support\Support Tools 
directory and placed on the hard drive because it will create a data file that is used for determining the 
packages that need to be repaired on the system. Leaving the source media in the cd-rom or in the 
default network share that it was installed from, prevents the installation from prompting for the source 
media.

Required software:

This script is written in vbscript and requires Windows Scripting Components, Internet Explorer 5.0 or 
better, and Windows Installer Service to execute correctly.

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run repair.vbs with 
default command line options. 

From a command line prompt window you can execute repair.vbs as follows: c:>cscript 
repair.vbs <options>

<Options>:

-checkbox when set enables the checkbox dialog selection. Checkbox selection is on by default.

-noreboot when set disables the reboot dialog check. Reboot is enabled by default if there are 
pending deletes before or after script execution.

-runrepair run a repair on all products found. Automatic execution of repair is disabled by default.

-remove enables the remove option from the GUI. Remove option is disabled by default.

-? -help -HELP displays help message for options.

Most common usage:    c:\> cscript.exe repair.vbs -remove

Back to Contents 
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If you are upgrading directly from OVIS 4.5 to OVIS 5.20 you may be interested in seeing the following 
list of new features that were in OVIS 5.0 and thus also available to you in OVIS 5.20:

OpenView Transaction Analyzer Integration Enhancements:

●     New user and failed transaction metrics added for easier problem identification.
●     OVTA service types expanded from WEBAPP to WEBAPP, COMAPP, JMSAPP, RMIAPP, 

and SOAPAPP, for better analysis and reporting capabilities.
●     Several new reports make data presentation more useful than ever.

OVO UNIX Integration Enhancements:

●     New state-based templates introduced so OVO Console will show changes in criticality of 
alarms when appropriate.

●     More flexible mapping of OVIS attributes in alarm messages.
●     Templates enhanced so that alarms are automatically sent to OVO if data is not received from 

the probe system within the expected time + 10 percent, to allow for minor delays.

NNM Integration Enhancements:

●     Added new probe integrations for SCRIPT, EXCHANGE, SOAP and OVTA service types 
WEBAPP, COMAPP, JMSAPP, RMIAPP, and SOAPAPP.

●     NNM 7.0 integration supported.

New Probes:

●     Script probe - Enables integration of scripts, including test tool scripts such as Mercury 
Interactive Loadrunner and Segue SILK. The \contrib directory on the Management Server 
contains example scripts for integration of test tools. 

●     Exchange probe (Windows only).
●     SOAP probe

Enhanced Probes:

●     All probes - Enhanced probes to eliminate the 255 character total configuration parameter 
limit. Increases usability with extremely long URLs, ODBC commands, and other lengthy probe 
parameter configuration settings.

●     Distribution manager - Enhanced to distribute user-specified files to support requirements of 
script probe as well as other user needs.

●     HTTP, HTTPS, HTTP_TRANS URL-mode, and SOAP probes - Support user-defined User-
Agent Header (ability to make it look like probe is coming from a different browser, e.g., from a 
cellular device).

●     HTTP and HTTPS probes - 
❍     Support for user-defined Host Header (useful for back-end load balancers in web

farm environments)
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❍     Support for a POST action.
❍     New mode for determining availability if an image is not available.

●     Web Transaction Recorder -  
❍     Retries parameter added.
❍     If "Capture Window on Error" is enabled, a choice of .gif or .bmp has been added.
❍     Better handling steps that do not load URL's by automatically including the 

ContinueClick flag.
❍     Better handling frames, specially dynamic frame names.
❍     New flag "docCompletes" which helps track when the page is fully loaded in special 

cases.
❍     Support for the option "Windows Event Recording" that better tracks the items clicked 

on the web page.
❍     Web Recorder modified to return to first step after a playback is stopped.
❍     Enhanced diagnostic capabilities enabled by registry settings to: 

■     Allow "Capture Window on Error" setting to create screen dumps with date and 
time stamp included in the file name so they will not be overlaid each interval.

■     Ability to write to separate trace file as well as trace.log for each HTTP_TRANS 
service group on a probe system.

■     Add tracing of downloaded object information to trace files 
❍     IE mode: support for more HTML tags.
❍     dynCmdSubst now supports replacement of the host part of a URL.
❍     IE mode: dlgCmd now supports forceful closing of a dialog (close command) and 

adding text to a text field (text command).
❍     IE mode: http/https proxies for HTTP_TRANS can be set to <no proxy> which instructs 

the probe to not use any proxies.
❍     IE mode: more descriptive error text for IE specific errors (IE 6.0 and higher).

●     LDAP probe -  
❍     Enhanced to support active directory and Kerberos with authentication fields. 
❍     Support for Secure LDAP (LDAPS) has been added.
❍     The LDAP port number has been added to the target field for better reporting and 

quicker root cause analysis from generated LDAP alarms.
●     Radius probe - Called-Station-Id & Calling-Station-Id attributes added.
●     DNS probe - pattern matching added.
●     Streaming Media probe -  

❍     New metric STREAM_SETUP_TIME added to measure initial buffering time. 
❍     Computation of congestion and response time metrics modified to better reflect server 

responsiveness.
●     Mailroundtrip/SMTP/POP/IMAP probes: 

❍     Targetinfo field modified to the
<recipient>@<SMTP host> - <user>@<POP3/IMAP4 host>
format to more correctly & uniquely identify targets in drill down reports.

❍     Enhanced to support large (1Mb) attachments.
❍     Enhanced to support custom headers/footers.

●     WAP and DIAL probes - Retries added.
●     DHCP probe -  

❍     Supports monitoring of DHCP relay agents.
❍     Supports monitoring of DHCP service in the network - broadcasts requests on the local 

subnet.
●     Custom Probes: 

❍     The compiler requirements changed for the Custom Probes SDK. See the Custom 
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Probes API Guide for these requirements.

Dashboard Enhancements:

●     Service Group selection box added to Availability, Response, and SLOs tabs, and also the 
Trends display.

●     Added error information for unavailable targets to Status display.
●     Added links in the Status Display from target information directly to the drilldown information.

Enhancements in Managing Remote Probe systems and Alarm Resiliency:

●     Alarms will be generated when information is not received from a remote probe systems in the 
expected time.

●     The alarm state is now maintained when the configuration is saved.

Configuration Enhancements:

●     Sort and find capabilities to save time and effort in navigating.
●     Locking mechanism to prevent multiple users from configuring at the same time.
●     Status screen now has right-click selections for measurement history or Dashboard drilldown.
●     Status screen has new error information fields added for quicker problem resolution.
●     Status screen has performance improvements.
●     Configuration options for locking mechanism and probe data received status.
●     For the iopsload utility, a refresh parameter has been added to allow changes without altering 

the regular probe interval data collection. A redirect option has been added to redirect output to 
a file for automated results checking.

●     The Probe Builder or Custom probes parameter "Password" is now displayed with asterisk 
characters for increased security. Or for custom or internationalized requirements, you can set 
a value in the registry instead of using the keyword Password.

●     Server trace file size may now be configured.

Licensing Enhancements:

●     "Enter License Directly" option was added in the Configuration Manager, Configure License 
dialog File > Configure License Dialog File > OVIS License selection.

●     Disabled transactions are no longer counted towards license limits.
●     Displays license counts for custom probe targets and HP-provided probe targets

separately (informational only).

 

The following are important changes in OVIS 5.0:

Updates to supported platforms:

●     Management server now supported on Windows XP Professional. 
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●     Windows NT 4.0 is no longer supported for the server or the probes.
●     Probes supported on SuSE Linux 32-bit Enterprise Server and Professional version 8.1 
●     Probes supported on Windows Server 2003.

File Locations:

●     httptrans.dat - The web transactions definition file's save location has changed from the OVIS 
probes directory to the Data\Datafiles directory on the management server. It is still 
distributed to the probes directory on both the management server and remote probe 
systems whenever the configuration is saved.

New Database fields:

●     Data fields added- The ERROR_INFO (VARCHAR 255) field was added to the 
IOPS_DETAIL_DATA table in the OVIS 4.5 release. The CONSUMER (VARCHAR 128) field 
has been added to the IOPS_DETAIL_DATA, IOPS_DETAIL_DATA_DAILY, and 
IOPS_DETAIL_DATA_HOURLY tables in the 5.0 release.

Also see the MSDE Security Alert information for OVIS 4.0 customers below.
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Legal Notices 
The information in this document is subject to change without notice.

Hewlett-Packard makes no warranty of any kind with regard to this manual, including but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall 
not be held liable for errors contained herein or direct, indirect, special, incidental or consequential 
damages in connection with the furnishing performance, or use of this material.

Warranty. A copy of the specific warranty terms applicable to your Hewlett- Packard product and 
replacement parts can be obtained from your local Sales and Service Office.

Restricted Rights Legend. All rights are reserved. No part of this material may be copied, reproduced, 
or translated to another language without the prior written consent of Hewlett-Packard Company. The 
information contained in this material is subject to change without notice.
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Use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 for DOD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer 
Software Restricted Rights clause at FAR 52.227-19 for other agencies.

HEWLETT-PACKARD COMPANY
United States of America

Copyright Notices. ©Copyright 2004 Hewlett-Packard Company, all rights reserved.

Reproduction, adaptation, or translation of this document without prior written permission is prohibited, 
except as allowed under the copyright laws.

Trademark Notices.

Adobe® is a trademark of Adobe Systems Incorporated.
Apache™ is a trademark of the Apache Software Foundation.
Check Point FireWall-1™ is a trademark of Check Point Software Technologies Ltd.
HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 
and 64-bit configurations) on all HP 9000 computers are Open Group UNIX 95
branded products.
Intel486 is a U.S. trademark of Intel Corporation.
iPlanet™ International and Netscape FastTrack Web Server™ are 
trademarks of the Sun/Netscape Alliance.
Java™ is a U.S. trademark of Sun Microsystems, Inc.
Microsoft® is a U.S. registered trademark of Microsoft Corporation.
Netscape™ and Netscape Navigator™ are U.S. trademarks of Netscape 
Communications Corporation.
OpenView® is a registered U.S. trademark of Hewlett-Packard Company.
Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, 
California.
Stronghold™ is a trademark of C2Net Software Inc.
UNIX® is a registered trademark of the Open Group.
Windows NT® is a U.S. registered trademark of Microsoft Corporation.
Windows® and MS Windows® are U.S. registered trademarks of 
Microsoft Corporation.
Microsoft® Internet Explorer is a registered trademark of Microsoft Corporation.
Certicom, the Certicom logo, SSL Plus, and Security Builder are trademarks of
Certicom Corp.  Copyright © 1997-2000 Certicom Corp.  Portions are Copyright
1997-1998, Consensus Development Corporation, a wholly owned subsidiary of
Certicom Corp. All rights reserved. Contains an implementation of NR signatures,
licensed under U.S. patent 5,600,725.  Protected by U.S. patents 5,787,028; 
4,745,568; 5,761,305.  Patents pending.

This product includes a copy of the Microsoft Data Engine (MSDE), redistributed
under the terms of Microsoft's End-User License Agreement.
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OpenLDAP Public License

The OpenLDAP Public License,  Version 2.3, 28 July 2000

Redistribution and use of this software and associated documentation ("Software"), with or without 
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices.

2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list 
of conditions, and the following disclaimer in the documentation and/or other materials provided with 
the distribution.

3. Redistributions must contain a verbatim copy of this document.

4. The name "OpenLDAP" must not be used to endorse or promote products derived from this 
Software without prior written permission of the OpenLDAP Foundation.

5. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear 
in their names without prior written permission of the OpenLDAP Foundation.

6. Due credit should be given to the OpenLDAP Project ( http://www.openldap.org/).

7. The OpenLDAP Foundation may revise this license from time to time.  
Each revision is distinguished by a version number.  You may use the Software under terms of this 
license revision or under the terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS ``AS 
IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE OPENLDAP FOUNDATION OR ITS 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE.

OpenLDAP is a trademark of the OpenLDAP Foundation.

Copyright 1999-2000 The OpenLDAP Foundation, Redwood City, California, USA.  All Rights 
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Reserved.  Permission to copy and distributed verbatim copies of this document is granted. 

 

NetBSD C Library Source

Copyright (C) 1996-2002 Internet Software Consortium.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is 
hereby granted, provided that the above copyright notice and this permission notice appear in all 
copies.

THE SOFTWARE IS PROVIDED "AS IS" AND INTERNET SOFTWARE CONSORTIUM DISCLAIMS 
ALL WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL INTERNET SOFTWARE 
CONSORTIUM BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL 
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS 
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.

$Id: COPYRIGHT,v 1.6.2.2 2002/02/12 06:05:48 marka Exp $

Portions Copyright (C) 1996-2001 Nominum, Inc.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is 
hereby granted, provided that the above copyright notice and this permission notice appear in all 
copies.

THE SOFTWARE IS PROVIDED "AS IS" AND NOMINUM DISCLAIMS ALL WARRANTIES WITH 
REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS. IN NO EVENT SHALL NOMINUM BE LIABLE FOR ANY SPECIAL, DIRECT, 
INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING 
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE.
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